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SuperReport Pro 
Version 4.6.3 

Release notes 

January 4, 2024 

Published by Plugin Masters worldwide 

https://pluginmasters.net 

SuperReport Pro forum 

System requirements 

SuperReport Pro version 4 is compatible with 4D v15, v16, v17, v18, v19, v20 and above, for both macOS and 
Windows in 32-bit and 64-bit modes. 64-bit only version is available separately, signed and notarized for 
macOS, “fat” version supporting Apple Silicon. 

Version 4.6.3 

 Fixed new bug in 4.6.2 - inverted condition for a section break (was breaking on equal values, not when 
value changed).  

Version 4.6.2 

 Fixed printing of a group when it must be removed  
o when a group is to be removed but it happens on next page (section continued on next page), the 

group was not printed, but objects below it were not moved, empty space was kept 
 Changed section break text comparison to "smooth"  

o since SRP 3.0, comparison for checking if break value changed was "exact": "Rose" # "rose" # 
"rosé" 

o now it should not break (the same it did before SRP 3.0), because "Rose" = "rose" = "rosé" 
 Fixed loading of XML  

o changed limit for width & height of any object from 1 to 0. Line having height of 0.25 now 
properly keeps that value (was ignored during loading, height remained at zero) 

 Added support for ":resID,index"  
o previously only ":xliff:name" was supported 

https://pluginmasters.net/
http://forums.e-node.net/viewforum.php?f=11
https://pluginmasters.net/
http://forums.e-node.net/viewforum.php?f=11
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Version 4.6.1 

 Changed implementation for object moving to not move objects to negative coordinates  
o when some oversized object is shrunk, objects below it (top coordinate of the objects is 

compared) are moved up 
o when the move would result in negative top coordinate, it will be moved to top (of the 

Section/Group) 
o this fixes bad Group printing (keep together and a variable moved beyond the top -> printed on 

next page) 
 Changed implementation for Table headers/footers measurement  

o when a cell row height is explicitly set (not zero) and is less than needed to print a line of text, 
minimum as defined by the style is used 

o this fixes empty cells: partially visible line is never printed -> empty cell was printed 
 Fixed implementation for Table headers/footers printing  

o some code was not using epsilon in [inaccurate] real arithmetic comparisons and thus didn’t 
properly work 

o this should fix error -211 when printing a Table object 
 Fixed a crash in Page Setup dialog on macOS 13.0.1 when report template contains unknown printer  

o workaround for Apple bug: stored Page Format is not fully used when it contains unusable 
printer, new Page Format is created for default printer with usable information (paper size, 
orientation, scaling) 

 Fixed font popup on macOS 13: froze while displaying both font panel and color panel 

Version 4.6 

 Fixed a memory leak in "For each" loop when iterating object properties 
 Fixed Table printing when column has set width which is less than header’s width  

o when column is too narrow, both wrap mode and auto-height are enabled, it will be split to 
multiple lines when measured 

o when printed, it uses header’s width (which means it can fit into the column w/o splitting to 
multiple lines) 

o -> empty space below the table 
 Fixed printing of pictures on Windows when using "Normal" or "Centered" (really old bug - SRP 3.0)  

o was using UnitPixel, thus size depended on actual DPI, now it uses correct UnitPoint 
 Changed text splitting to not split words on '.' & ',', only on space & line end 
 Fixed crash with long scripts to be shown as tool tip (by limiting the length to 20 lines) 
 Added new property to not show tooltips for scripts  

o name SRP_Report_ShowScriptTips 
o value "enst" 
o type Boolean 
o xml name = "scriptTips" 
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o read/write/persistent 
o default true 

 Added new menu item for that property (ID 380, "Show Scripts Tooltips" in View menu) 
 HTML export includes STYLE tag for text objects (font name, size, decoration, color) 

Version 4.5 

 Fixed a possible crash when parsing a report 
 Fixed a memory leak on Mac (when printing images) 
 Fixed dynamic variable parsing  

o <%=expression;format%> now supports semi-colons inside the expression, does not simply look 
for first semi-colon to get the format 

 Fixed For loop expression parsing in scripts  
o For (var; expression1; expression2; expression3) now supports semi-colons inside the expressions, 

does not simply look for first semi-colon to find the next part 
 Added implementation for For each loop in scripts 
 Fixed session printing on Windows when using internal PDF generator and no template is used for page 

setup  
o it didn’t work (zero-sized page -> error -211), now it uses default page setup of the default 

printer 
 Fixed Table printing when some column is attributed but table does not use headers or footers  

o column loosed that "is attributed" property, now it is preserved 
 Fixed implementation of getter for SRP_Area_IsArea  

o when used with report reference, it returned 0; now it resolves the area and returns 1 if it 
succeeds 

o it does not TRACE when used with SR_GetLongProperty 
 Added possibility to delete columns from Table during printing  

o SR_ModifyTable can be used with SRArea as $1 when $2 parameter is object ID of a Table and 
$3 is 3 (delete column(s)) 

 Notes  
o scripts can be executed in Editor (using "show values" - cmd-shift-V) and it is not a good idea to 

delete columns there (at least without maintaining the undo buffer) 
o scripts can be executed more than once: the report is processed 3 times when using "count pages" 
o we suggest to use something like this:  
If (SR_GetLongProperty (SRArea;1;SRP_Area_IsArea)=1) 
  ALERT("Not a good idea to remove columns in editor!") 
Else  
  If (SRCurrentRun=1)   // only when starting the printing 
     SR_ModifyTable (SRArea;SRObjectPrintRef;3;lNumColumnsToUse+1;100)   
// remove columns lNumColumnsToUse+1 to the end, 
// leaving only first lNumColumnsToUse columns 
  End if  
End if 
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Version 4.4 

 "Fat" for 64-bit, including Apple Silicon, arm64 architecture set for macOS 11+ 
 Fixed XML/HTML export (text longer than 1023 UTF-8 bytes produced corrupted output) 
 Fixed table cell positioning code (undo support) 
 Fixed table cell positioning & columns width calculation when width is set for a cell spanning multiple 

columns 
 When running compiled and displaying ALERT, if the option key is down when the alert is closed and 

control is returned to SuperReport Pro, it will clear bit 1 of SRP_Area_TraceOnError (if it was 3, it will 
be 1)  

o option-click OK to disable "endless" ALERT 

Version 4.3 – New features 

 Added access to the report and data source objects during printing  
o 1 as object number refers to the report itself (identical to area or offscreen report) 
o -> previously it referred to the first object in first section 
o report object supports SRP_Report_DataSource (and returns 2) 
o array of objects obtained with SR_GetObjects ($reportRef; 1; SRP_ReportAllObjects; 

$alObjectIDs) still does not contain all objects (like the Report, DataSource or any Section) 
o just the objects are numbered starting at 3, not at 1 
o __SRP_ds:=SR_GetLongProperty (SRArea;1;SRP_Report_DataSource) 
o __SRP_dataSource:=SR_GetLongProperty (SRArea;__SRP_ds;SRP_DataSource_Source) 
o see http://forums.e-node.net/viewtopic.php?f=11&t=969 

 New option for internal PDF generator on Windows:  
o constant SRP_Print_WinPDFAllFonts, value 4194304 
o when used, all fonts (including the 14 standard fonts defined by PS standard) are included in the 

generated PDF 
o -> workaround for WebArea not properly handling PDF when all fonts are not included 

Version 4.3 – Changes 

 When SRP_Print_Win10PDFPreview is used, the PDF generated in response to File > Preview should 
be open [with default application] 

o -> SuperReport Pro was checking 
"Computer\HKEY_CURRENT_USER\Software\Microsoft\mxdwdui\OpenAfterCreation" 
the same way as for XPS preview, now it does not do that for PDF 

http://forums.e-node.net/viewtopic.php?f=11&t=969
http://forums.e-node.net/viewtopic.php?f=11&t=969
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Version 4.3 – Fixes 

 Fixed ancient bug in Table object handling  
(when header/footer contains adjacent cells with rowSpan > 1) 

 Fixed Trace mode Alert (didn’t provide command name since switch to manifest.json) 
 Mac specific: fixed old picture scaling bug when "scale to fit" is used (was not scaling up) 
 Windows specific: fixed a crash in newest 4D v17.4 (build 257556 +) and 4D v18.3 (build 257318 +) 

when 4D print setting are to be used (using SRP_Print_4DPageSetup | SRP_Print_4DJobSetup) 
-> 4D finally implemented Plugin API accessors to PRINT SETTINGS in 64-bit versions, but the 
format has changed on Windows and older SuperReport Pro will crash 

 Fixed Mac PDF feature when using session printing: paper (size, orientation, scaling, margins) from a 
report printed in a session is used only when the session was created with SRP_Print_DestinationPDF, 
otherwise the settings in the session are used for all reports 

 Fixed Preview on Windows when Win10 Print to PDF is used 
-> SuperReport Pro was accidentally checking for XPS writer option "automatically open generated file" 

Version 4.2.1 – Fixes 

 64-bit version signed & notarized 
 Fixed drawing of rotated text 
 Changed dialogs (bug with watermark section) 
 Changed graphic palette (watermark was handled identically to header) 
 Fixed "page-throw before" in break headers on first iteration 

Version 4.2 – New features 

 Variable/Field picture format combo box in the graphic property palette now honors entering numeric 
values (e.g. “1” for “centered”) 

 "Print at Bottom" is now settable for a Footer section (for PagePro compatibility) 

Version 4.2 – Fixes 

 Adjusted dialogs & palette for that "Print at Bottom" checkbox 
 Fixed picture drawing on Mac when format is set to "scaled to fit" 
 Fixed getter for SRP_Report_MacPrinter: should not return garbage, but a real printer name as stored 

in PageFormat under the key “com.apple.print.PageFormat.FormattingPrinter” 
 Fixed a freeze on 64-bit 4D Server v17R5 on Windows when displaying a dialog 

 Larger space for German strings 
 Fixed property/XML attribute name lookup for text palette (using the new "extendNoDuplicates" for 

Table object) 
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Windows specific: 
 Fixed mouse position computation during Idle event (object was “jumping” during move/resize when 

you wait a while after mouse move; 4D v16+) 
 Fixed handling of printer specified on command line (SR_OpenSession/SR_Print@) when 

SRP_Print_AskJobSetup is used:  now the specified printer is selected in the dialog 

Version 4.1 – New features 

 Added TYPE attribute into section tag of XML export 
o NAME and ID are settable by end user, TYPE is the real type (header, body, breakfooter, …), 

to simplify export 
o <Section type="Header" name="Header" id="section_00">  
o <Section type="Body" name="Body" id="section_07">  

 Added Table object property SRP_Table_ExtendNoDuplicates 
o scope Table, value "codu", type Boolean, default 0 (False), read/write/persistent, xml name 

"extendNoDuplicates" 
o when set to 1 (True), all repeating values in all columns are suppressed 
o default is to print all values even when they are identical after first changed column (like in break 

processing) 
o see the technical note 

 New feature for Windows 10: when printing to PDF (SRP_Print_DestinationPDF) and "Win10 PDF" 
is specified (SRP_Print_Win10PDFPreview) and "Microsoft Print to PDF" printer exists, it is used for 
PDF creation (using margins from report) 

 Added support for alpha channel in PNG in PoDoFo (internal PDF generator) – Windows only 
 Added support for RTL text layout (text in editor or during printing, not in editor as such) 

Version 4.1 – Changes 

 Palette positions are automatically saved and restored 
 Increased allowed maximum section height from 4096 to 16384 
 Improved behavior for object grouping: previously the objects were put into the group in order of 

selection, now they are put in printing order 
 Added missing menu handler for Default alignments (both horizontal and vertical) 
 Modified behavior for printing break headers having SRP_Section_Break_Always set to 1 (print on 

each page) when it is printed due to new page, not to a break: 
o old behavior: section is processed as usual (same as when a break occurred) and is printed 
o new behavior: section is not processed as usual (no script is executed -> e.g. no way to suppress 

section printing), cached preprocessed section from previous page is used with values used on 
previous page, only objects in the break header having SRP_Object_Draw = 2 (on overflow) or 3 
(always) are printed, the only dynamic data is variable referring internal report variable (like 
SRPage) 

https://pluginmasters.net/en/ftp/SuperReportPro/SuperReportPro_TechNote_Extend_no_Duplicates.pdf
https://pluginmasters.net/en/ftp/SuperReportPro/SuperReportPro_TechNote_Extend_no_Duplicates.pdf
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o this should be very similar to PagePro behavior 
 Added UI for SRP_Section_Break_Always in SRP_Dialogs & SRP_Palette 
 Modified behavior: printing in area now uses SRP_Area_PreviewFlags 

o if, for example, you suppress progress dialog for File->Preview, it will be used for File->Print, too 
 Modified Table object to use relate many/relate one when fetching data for first-level columns 

o table object was designed to require use of a script to fetch the needed related data 
o now it is modified to do auto relate one/many when fetching fields of the first-level columns 

(usually SRP_Column_ExecutionLevel = 0) to support AreaList Pro printing (AL_SuperReport 
with AreaList Pro displaying fields from related main table) 

 Known issue – 4D bug ACI0099364 
Running 64-bit on Mac: 4D does not provide the page setup/job setup - it seems that the calls are 
simply not implemented (PA_GetCarbonPageFormat and PA_GetCarbonPrintSettings return NULL 
in Cocoa) 

 When a removed group is the only object in the section, the empty space below it is removed, too 

Version 4.1 – Fixes 

 New $0 result value 2 honored from Editor event callback function (set with 
SRP_Area_CallbackMethEdit):  

o 2 = cancel object creation (only meaningful if CallbackType is 1) 
 Fixed a bug in Add Section dialog (not properly getting break level from existing sections) 
 Fixed palette interface not honoring "virtual" structure names defined by the developer 
 Improved variable substitution parser: calling a function with more parameters should work 

o previously the first semicolon was used to determine where the variable name ends and optional 
format begins - it is ok for a variable, but definitely not for a command like 
'<%=MyCallbackFunction(1;2;3);"|MyFormat"%>’ 

 Fixed script execution for nested Case of statements 
o Else of the outer Case of was always executed when a : (case) ended with [nested] End case 

 Fixed unnecessary redraw requests when an area is covered by another window 
 Fixed a serious bug when using SRP_Print_4DPageSetup on Mac - now the page orientation and 

scaling should be honored 
 Fixed a small bug in setter for variable names 

o e.g. SR_SetTextProperty (0;0;SRP_Area_VarDate;"RWDate") returns internally 1 meaning 
"name was set" (zero for "var name not set") and thus you see a TRACE (on error 1) 

 Added missing case for SRP_Area_VarRepeat in setter (always returning -6 = invalid request) 
 Added fix for bad Text object loading (reading LF + TAB + TAB + TAB after the actual text and 

before next child node) 
o when an object contains HTMLStartTag or HTMLEndTag child nodes, Text is searched for 

LF (linefeed) and anything form that position is deleted 
o new XML uses attributes for HTMLStartTag and HTMLEndTag, not child nodes 
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Version 4.0 

 Compatibility with 64-bit mode and 4D v16+ on macOS and Windows 
 New palette interface (graphic and/or text) – see the documentation for details 

Printing AreaList Pro areas 

AreaList Pro allows printing or saving as HTML through SuperReport Pro. It only takes two lines of code to 
print an AreaList Pro area. Additional options are available, such as automatic column width and use of 
SuperReport Pro style properties instead of the existing AreaList Pro area settings. 

Upgrading from previous versions 

Any v4 license key will activate any v4.x version. 

Upgrades from versions 3.x and previous versions are available at https://pluginmasters.net/srp. 

Contact 

Upgrade requests, sales and license information: orders@pluginmasters.net 

Technical issues, discussions and requests on the support forum. 

SuperReport Pro web page: https://pluginmasters.net/srp 

 

https://pluginmasters.net/en/ftp/SuperReportPro/SuperReportPro_v4_Addendum.pdf
http://www.e-node.net/srp
mailto:orders@pluginmasters.net
http://forums.e-node.net/viewforum.php?f=11
http://www.e-node.net/srp
https://pluginmasters.net/en/ftp/SuperReportPro/SuperReportPro_v4_Addendum.pdf
http://www.e-node.net/srp
mailto:orders@pluginmasters.net
http://forums.e-node.net/viewforum.php?f=11
http://www.e-node.net/srp
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